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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published December 2013. 

© 2013 Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners. 
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Overview 
Welcome to the Deltek Vision Version 7.1 release. These release notes contain a summary of the 
following: 

 Pre-Installation Information 

 Enhancements 

 Software Issues Resolved 

 Database Changes 

Important Note for Customers Upgrading from Vision 6.x 
If you are upgrading to Vision 7.1 from a version earlier than Vision 7.0 SP1, you should read the 
Vision 7.0 SP1, 7.0, 6.2, and any prior relevant release notes to ensure that you understand all 
the technology, software changes, and enhancements that have been implemented and how 
these changes may affect you. 

You can download the release notes from the Deltek Customer Care Connect site at 
http://support.deltek.com. 

http://support.deltek.com/
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Pre-Installation Information 
Please review the contents of this section before you install Deltek Vision 7.1. 

 

See the Deltek Vision Technical Installation Guide for instructions on how to download and 
install the Vision software. You can download this guide from the Deltek Customer Care 
Connect site at http://support.deltek.com. 

Non-Supported Environments 
The following are non-supported environments for Vision 7.1: 

 Vision does not support using Microsoft Windows® XP, Widows Vista™, or Windows 7 for 
production server installation. 

 Vision is not compatible with Microsoft Windows 95, 98, ME, 2000, or NT® 4.0 as a client or 
server Operating System. 

 Vision no longer supports Microsoft SQL Server™ 2000 or Microsoft SQL Server 2005. 

 Vision no longer supports Windows 2000 Server or Windows Server 2003. 

 Vision no longer supports Actuate. 

 You cannot perform a Single Server deployment on the Microsoft Small Business Server. 
Only the Vision database tier or report tier can be installed on this server. 

 You cannot install any Vision tier on the Microsoft ISA server, or any other software-based 
firewall (except Windows firewall). 

 You cannot install any Deltek Vision tier on any server with Microsoft Terminal Services 
(Application Mode Only) running. Terminal Services in remote administration is fully 
supported.  

 You cannot install any Vision tier on a Domain Controller. 

 You cannot install any Vision tier on any version of Microsoft Exchange Server. 

 You cannot install any Vision tier (except Document Management) on any version of 
SharePoint Server. 

 Vision is not compatible with Microsoft Project 2003. Importing and/or exporting to Microsoft 
Project 2003 from the Planning application will produce an error. 

 Platform Virtualization is a new technology that allows multiple operating systems and 
platforms to run simultaneously as separate virtual machines on a single set of server 
hardware. See Deltek’s Virtualization Statement, available on the Deltek Customer Care 
Connect site, for limitations of support for virtualized deployments. 

 Microsoft’s Application Request Routing (ARR) 3.0 is not supported in Windows Server 2012 
because at the time of release of Vision 7.1, ARR 3.0 was still in Microsoft Beta. 

http://support.deltek.com/
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Technical Considerations 
The following are technical considerations for Vision 7.1: 

Technical Consideration Description 

Running multiple versions of Vision Vision 7.1 and earlier versions of Vision cannot be run 
at the same time on the same Web/Application server. 

Microsoft .NET Framework 3.5 SP1 Microsoft .NET Framework 3.5 SP1 must be installed 
on the following: 

 All client workstations running Deltek Vision. 

 The servers hosting the Vision Application and 
the Process servers. 

64-bit processing Vision supports 64-bit processing for: 

 All Vision logical tiers (web/application, 
database, and report tiers) 

 The client tier (Windows 7, Windows Vista, and 
Windows XP) 

Windows Server versions Vision supports the following Windows Server versions: 

 Windows Server 2012 

Document Management is not supported on 
Windows Server 2012 because SharePoint 
2010 is not yet supported on Windows Server 
2012. 

 Windows Server 2008 R2 SP1  

 Windows Server 2008 SP2 

SQL 2012 Availability Groups 

 

Although Vision 7.1 supports SQL 2012, it does not yet 
support SQL 2012 Availability Groups. If you install 
Vision 7.1 to a SQL Server that is configured with 
Availability Groups and you add your Vision database 
to that Availability Group, you may see a Use 
Availability Groups check box on the General tab in 
Vision Weblink. Do not select this check box. Vision 
support for SQL 2012 Availability Groups, specifically 
Read-Only Routing, will be announced at a future date. 

Microsoft SQL Server Database 
Engine and Reporting Services and 
Analysis Services 

Vision supports the following versions of Microsoft SQL 
Server Database Engine and Reporting Services: 

 Microsoft SQL Server 2012 SP1 + CU1 

 Microsoft SQL Server 2008 R2, SP2 + CU1 

 Microsoft SQL Server 2008, SP3 + CU6 
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Technical Consideration Description 

Microsoft SQL Server Reporting 
Services 

Microsoft SQL Server Reporting Services: 

 Must be installed and configured before you 
run the Vision installation. Follow the Microsoft 
documentation for your installation. 

 Are supported in Native Mode configuration 
only. The SharePoint Integrated Mode is not 
supported. 

Microsoft SQL Server Analysis 
Services 

This is supported in Multidimensional Mode only. The 
Tabular Mode introduced with SQL 2012 is not 
supported. 

Windows Server with IIS Vision supports: 

 Windows Server 2012 with IIS 8.0 

 Windows Server 2008 with IIS 7.0 

 Windows Server 2008 R2 with IIS 7.5 

Microsoft Windows Vision can be run as a client on any of the following: 

 Microsoft Windows XP (SP3) 

 Microsoft Windows Vista (SP2) 

 Microsoft Windows 7 SP1 

 Microsoft Windows 8 

Microsoft Internet Explorer Vision can be run with Microsoft Internet Explorer 
versions 10.0, 9.0, 8.0, and 7.0. 

Microsoft Office 2010  Vision supports the 32-bit version of Microsoft 
Office 2010. 

 Microsoft Office 2010 is also supported for use 
with Vision Connect for Microsoft Outlook. 

Microsoft Project Vision is compatible with: 

 Microsoft Project 2010 

 Microsoft Project 2007 

Vision Document Management Vision supports the following for Document 
Management: 

 Microsoft SharePoint Server 2010 SP1  

 Microsoft SharePoint Foundation Server 2010 
SP1 

 Microsoft SharePoint Server 2007 SP3 

 Microsoft SharePoint Services 3.0 SP3 
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Technical Consideration Description 

Document Management is not supported on Windows 
Server 2012. 

Vision Connect for Microsoft Outlook Vision Connect for Microsoft Outlook: 

 Is not supported with Microsoft Windows 8. 

 Is supported with Microsoft Office 2010. 

Important Notes About the Vision Installation 
This section provides important information specific to the Vision 7.1 installation. 

Microsoft SQL Server Express Edition 
Deltek Vision 7.1 supports Microsoft SQL Server Express with Advanced Services. 

If you are implementing SQL Server Express Edition, Deltek recommends that you use SQL 
Server 2012 SP1 Express with Advanced Services as the Database and Report Server for your 
Vision implementation. The Express Edition with Advanced Services contains the Database 
Engine and Reporting Services that are required for managing the database and running reports. 

Deltek no longer distributes the SQL Express Server installation. You can download the 
appropriate SQL Server Express edition with Advanced Services that matches your operating 
system platform (32-bit/x86 or 64-bit/x64) from Microsoft. For example, install the 32-bit/x 86 on a 
32/x 86 system only and the 64-bit/x 64 on a 64-bit system only. You cannot mix the operating 
system types. 

For your convenience and to avoid confusion, we have provided the direct links for the SQL 
Server 2012 SP1 with Advanced Services installation packages. Click the following link to access 
the download page: 

http://www.microsoft.com/en-us/download/details.aspx?id=35579 

Use these links for the two downloads: 

 64-bit / x64 Installation for 64-bit Operating Systems: 

http://download.microsoft.com/download/5/2/9/529FEF7B-2EFB-439E-A2D1-
A1533227CD69/SQLEXPRADV_x64_ENU.exe (1.9 GB) 

 32-bit / x86 Installation for 32-bit Operating Systems: 

http://download.microsoft.com/download/5/2/9/529FEF7B-2EFB-439E-A2D1-
A1533227CD69/SQLEXPRADV_x86_ENU.exe  (1.9 GB) 

After you install SQL Server Express, Deltek recommends that you download and install the 
following cumulative update package 1 (CU1) for SQL Server 2012 Service Pack 1 from 
Microsoft: http://support.microsoft.com/kb/2765331. 

 

The following Microsoft link provides information on prerequisite requirements, release notes, 
installation guide and other helpful links for performing the SQL Server Express installation of 
SQL Server: http://technet.microsoft.com/en-us/sqlserver/install 

Supported Versions of Microsoft SQL Server 

http://www.microsoft.com/en-us/download/details.aspx?id=35579
http://download.microsoft.com/download/5/2/9/529FEF7B-2EFB-439E-A2D1-A1533227CD69/SQLEXPRADV_x64_ENU.exe
http://download.microsoft.com/download/5/2/9/529FEF7B-2EFB-439E-A2D1-A1533227CD69/SQLEXPRADV_x64_ENU.exe
http://download.microsoft.com/download/5/2/9/529FEF7B-2EFB-439E-A2D1-A1533227CD69/SQLEXPRADV_x86_ENU.exe
http://download.microsoft.com/download/5/2/9/529FEF7B-2EFB-439E-A2D1-A1533227CD69/SQLEXPRADV_x86_ENU.exe
http://support.microsoft.com/kb/2765331
http://technet.microsoft.com/en-us/sqlserver/install
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The following versions of Microsoft SQL Server Database Engine and Reporting Services can be 
used with Vision 7.1: 

 Supported versions: 

 Microsoft SQL Server 2012 SP1 + CU1 (build 11.00.3321) Standard and Enterprise 
editions 

 However, SQL Server 2012 is not yet supported for creating Vision custom reports 
with SQL Server 2012 report writing tools—Report Builder 3.0 and SQL Server Data 
Tools (formerly called Business Intelligence Development Studio). 

 Microsoft SQL Server 2008 R2 SP2+ CU1 (build 10.50.4260.0) 

 Microsoft SQL Server 2008 SP3 + CU6 (build 10.00.5788.00) 

 Compatible versions: 

 Microsoft SQL Server 2008, SP3 (build 10.00.5500.00) 

 Microsoft SQL Server 2008 R2 SP1+ CU1 (minimum build required 10.50.2769.0) 

 Microsoft SQL Server 2008, SP2 (minimum build required 10.00.4000.00) 

 

Supported versions are the most current, actively tested technologies used to deploy Vision. 
Compatible versions are recent technologies that have been previously supported and tested for 
deploying Vision. However, these are not actively being tested but are believed to be compatible 
with Vision. 
For a full explanation of supported versus compatible versions and a more detailed list of 
Microsoft SQL Server releases (R), service packs (SP), and cumulative updates (CU) that Vision 
supports, see the Deltek Product Support Compatibility Matrix. You can download this PDF 
document at the Deltek Customer Care Connect site at http://support.deltek.com. 

Windows Server 2008 R2 
If you deploy Deltek Vision 7.1 with Windows Server 2008 R2, you must configure the 
DeltekVisionAppPool Identity (IIS) and the Report Server Windows Username (Report Server tab 
of Weblink) to be the same domain account. This must also match the domain account profile 
where your network printers are installed on the Vision web/application server. 

Vision Document Management and Microsoft SharePoint Foundation 2010 
With the release of Deltek Vision 7.0 and later, SharePoint® Foundation 2010 (SPF) will replace 
Windows SharePoint Services 3.0 (WSS)—if all operating system prerequisites have been 
satisfied. 

The following list contains important information about SPF and the Vision Document 
Management installation as it relates to new installations and upgrades: 

 SharePoint Foundation 2010 hardware and software requirements can be found here: 
http://technet.microsoft.com/en-us/library/cc288751.aspx 

 SPF requires either Windows Server 2008 x64 or Windows Server 2008 R2 x64 as the 
operating system for installation. 

 If the Vision Document Management installation is run on either Windows Server 2008 x64 or 
Windows Server 2008 R2 x64, SPF will be the default version of SharePoint installed. 

 If the Vision Document Management installation is run on Windows Server 2008 (x86), WSS 
3.0 SP2 will be the default version of SharePoint installed. 

http://support.deltek.com/
http://technet.microsoft.com/en-us/library/cc288751.aspx
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x64 for the database tier is required by SPF 2010. 

The Vision Document Management installation does not check to ensure the database 
prerequisites have been met. 

 The SPF installation requires that a number of prerequisite components be installed and it 
includes an installation program to install these prerequisite components. The Vision 
Document Management installation will run the Prerequisite Installer and check the log file to 
validate that it completed successfully. 

 Upgrades of Vision Document Management will only upgrade the Deltek-specific 
files. Upgrades from WSS to SPF are not supported with the installation. Upgrade information 
from Microsoft can be found here: http://technet.microsoft.com/en-
us/sharepoint/ee517215.aspx. 

 

Deltek highly recommends that any upgrades from WSS to SPF be performed before the 
installation of Vision Document Management and that any previous installations of Vision 
Document Management be uninstalled so that the installation can handle the version of 
SharePoint correctly as a new installation rather than an upgrade. 

 

For additional information, see the Deltek Vision Document Management Installation Guide. 
You can download this guide (in PDF format) from the Deltek Customer Care Connect site 
at http://support.deltek.com. 

Connect for Microsoft Outlook 

New Users are Unable to Install Connect for Microsoft Outlook and Existing Connect for 
Microsoft Outlook Users are Unable to Synchronize 

This section applies if you are upgrading to Connect for Microsoft Outlook 7.1 from an earlier 
version. 

After you upgrade your Vision Web server to Vision 7.1, you must download and install Connect 
for Microsoft Outlook 7.1 onto your Vision Web server from the Download Software Manager 
(DSM). If you have multiple Web servers, complete this step for each server. 

If you upgrade the Vision software, but do not upgrade the Connect for Microsoft Outlook 
software, new Connect for Microsoft Outlook users will be unable to install the Connect for 
Microsoft Outlook client from Vision Utilities. They will receive a “500” error message from the 
Web server. In addition, existing users will not be able to synchronize because they have the old 
Connect for Microsoft Outlook version installed. 

 

See the Deltek Vision 7.0 SP1 Connect for Microsoft Outlook Installation Guide for specific 
instructions for performing new and upgrade deployments. 

Microsoft SQL Server Reporting Services and Custom Reports 
The software requirements for creating Vision custom reports with Microsoft SQL Server 
Reporting Services have changed in Vision 7.0 and later releases. To create custom Vision 
reports, use either of the following: 

 Report Builder 2.0 — Report Builder 2.0 is available in Microsoft SQL Server 2008 SP1. See 
http://blogs.msdn.com/b/sqlrsteamblog/archive/2009/04/07/sql-server-2008-sp1-and-report-
builder-update.aspx for more information. Report Builder 1.0 is no longer supported for 
creating Vision custom reports. 

http://technet.microsoft.com/en-us/sharepoint/ee517215.aspx
http://technet.microsoft.com/en-us/sharepoint/ee517215.aspx
http://support.deltek.com/
http://blogs.msdn.com/b/sqlrsteamblog/archive/2009/04/07/sql-server-2008-sp1-and-report-builder-update.aspx
http://blogs.msdn.com/b/sqlrsteamblog/archive/2009/04/07/sql-server-2008-sp1-and-report-builder-update.aspx
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 Microsoft Business Intelligence Development Studio 2008 (also known as BIDS 2008 or 
Report Designer 2008) — BIDS 2005 is not supported for creating Vision custom reports. 

Copying Template Files 

When you create custom reports on your workstation with BIDS 2008, you must copy the .rdl 
template files to the following location on your workstation: 

C:\Program Files\Microsoft Visual Studio 9.0\Common7\IDE\PrivateAssemblies\ProjectItems\ReportProject  

instead of this location: 

C:\Program Files\Microsoft Visual Studio 8\Common7\IDE\PrivateAssemblies\ProjectItems\ReportProject  

Modifying Custom Properties 

In BIDS 2008, you can now modify custom properties for a report on the Properties window of the 
report. In the Properties list, navigate to CustomProperties. Click the  ellipsis button to open 
the Custom Properties dialog box. Previously, you had to use the View Code option to modify 
custom properties. 

Custom Reports Created with Microsoft SQL Server Reporting Services 2005 

For Vision custom reports that were created with Microsoft SQL Server Reporting Services 
(SSRS) 2005, you must use BIDS 2008 or Report Builder 2.0 to upgrade the reports to SSRS 
2008 before you can use them in Vision 7.0 and later releases. 

After you upgrade the reports, you must update report queries to revise any database table 
names that have changed in Vision 7.0 and later releases. 

Vision Table Name Changes that Affect Custom Reports 

Table Name in Vision 6.x Table Name in Vision 7.0 

CFGCountry FW_CFGCountry 

CFGCurrency FW_CFGCurrency 

CFGPhoneFormat FW_CFGPhoneFormat 

CFGEnabledCurrencies FW_CFGEnabledCurrencies 

InfoCenterTabHeadings FW_InfoCenterTabHeadings 

ReportPrinters FW_ReportPrinters 

Other Vision 7.0 framework changes that are applied within the report business objects may 
affect your custom reports after you upgrade, causing them to not work properly. If a custom 
report does not work properly after you upgrade it to SSRS 2008 and update any renamed 
database tables, Deltek recommends that you recreate the custom report using Vision 7.0 and 
BIDS 2008 or Report Designer 2.0. 

Consider the following before you recreate a custom report with BIDS 2008 or Report Builder 2.0: 

 Do you still need the custom report? 

 Are there standard reports in Vision 7.0 that provide the information that you need? 
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 Is the custom report that you created with BIDS 2005 or Report Builder 1.0 based on a Vision 
standard report? If so, you can start with a standard Vision report and modify it in BIDS 2008 
or Report Builder 2.0 to recreate your custom report. 

 

 

If you need additional assistance with custom reports, contact the Deltek Consulting Services 
Group at CustomServices@Deltek.com. 

For detailed information and training on how to design a Vision report with BIDS or Report 
Builder, Deltek University offers report writing classes. 

For class offerings, see http://www.deltek.com/services/deltekuniversity. 

 

Specific instructions on upgrading custom reports created with SSRS 2005 in BIDS 2008 and 
Report Builder 2.0 are included in the Deltek Vision 7.0 Custom Reports and Microsoft SQL 
Server Reporting Services Guide. 

Custom Invoice Templates and Other Custom Forms Created with 
Microsoft SQL Server Reporting Services 2005 

You must use BIDS 2008 to upgrade custom invoice templates and other custom reports used for 
Deltek forms (such as Purchase Order forms, Purchase Requisition forms, and Request for Price 
Quotes) that were created with SSRS 2005. You must upgrade them before you can use them in 
Vision 7.0 and later releases. 

The information in the previous section titled “Custom Reports Created with Microsoft SQL 
Server Reporting Services 2005” also applies for invoice templates and other custom Deltek 
forms. Refer to that section for information on how to upgrade invoice templates and other 
custom forms. 

Known Issues with the Vision 7.1 Installation 
 In certain circumstances, the databases.enc entries for the Report Server Configuration tab 

are not being filled in. Please check your database entries using Weblink, and test the 
database and Report Server configurations to ensure that they are accurate. 

 If you are upgrading from a 6.x version of Vision and you use a Microsoft SQL Server 
Session State that is located in a database other than your Vision database, see KB article 
#72573 for additional instructions. During the Vision upgrade process, the SessionState table 
is renamed. However, if the table is not located in the Vision transaction database, it will not 
be renamed. You must manually rename the table using the instructions in the KB article. 

 

If you encounter any problems with your installation, contact Deltek’s Global Services team at 
DGSConsultants-PES@deltek.com. 

mailto:CustomServices@Deltek.com
http://www.deltek.com/services/deltekuniversity/
mailto:DGSConsultants-PES_Vision@deltek.com
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Deploying Vision 7.1 on Client Workstations 
The switch to Smart Client technology beginning with Vision 6.0 requires that compiled 
application code be stored on each user’s PC. ClickOnce is the Microsoft technology used to 
install this code without requiring that IT manually install Vision on each user’s machine. The 
code is downloaded automatically when Vision is opened on the user’s PC. 

 

You must manually install .NET 3.5 SP1 on each workstation on which Vision 7.1 will be run. 

Each time that you open Vision, the application automatically checks the server for any changes, 
such as a hot fix or a version upgrade. If no change is detected, Vision opens. If software updates 
are available (and they have been pushed out by your IT department) the updates are 
downloaded automatically. 

When you open Vision 7.1 for the first time: 

1. The Deltek Vision launch page displays. Click Run on this page to continue. Vision 
downloads the files required to open the Login screen. 

The Deltek Vision Login screen then displays.  

2. Enter your Username and Password, select a Database, and click Login. 

3. When you click Login, Vision downloads a zip file to your workstation (an Application 
Downloader dialog box displays during this process). This zip file is extracted into the 
local ClickOnce cache on your workstation. This is similar to the way temporary Internet 
files are stored for browser applications. After the zip file is extracted, the Vision 
application opens and you can start working. 

On subsequent logins, assuming no software updates have been received from Deltek, the Vision 
application opens on your workstation when you log in—no download will be necessary. When 
Deltek provides a new version of the software, or a hot fix, and your IT administrator installs the 
new version or hot fix, Vision will detect and download the update automatically when you log in. 

Upgrade Considerations 
Deltek encourages clients to upgrade to the latest version of Vision because: 

 New features are added only to the latest version. 

 Except in critical situations, Deltek fixes software issues only in the latest version. 

 Deltek support is typically available only for the latest and the next previous versions. 

 The latest version incorporates the newest technologies and tools. 

Before upgrading, you should first review these release notes and perform a test conversion and 
test installation of the new version to ensure that your firm’s business processes are working 
properly in the new version. 

 

If you are upgrading to Vision 7.1 from a version earlier than Vision 6.1, see the 6.1 release 
notes. You can download them (in PDF format) from the Deltek Customer Care Connect site at 
http://support.deltek.com. 

Knowledge Center article 66930 provides a list of all the 7.x documentation. 

http://support.deltek.com/
https://deltek.custhelp.com/app/answers/detail/a_id/66930
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Deltek’s Global Services team is available to support you as you plan for this upgrade. We offer 
both technical and custom services to ensure the best possible Deltek experience. Contact 
DGSConsultants-PES@deltek.com. 

Custom Programming 
Before you upgrade to Vision 7.1: 

 Review all existing custom work at least eight weeks prior to your intended go-live date. 

 Compare your custom work to the new functionality provided in this release. 

 If this new version possesses the functionality contained in your custom work, these custom 
programs may no longer be needed. If the functionality contained in your custom work is not 
provided in this release, you must ensure the custom work remains intact through the 
upgrade process. 

 Identify any hot fixes or patches that you plan to deploy with your Vision 7.1 upgrade. Ensure 
that, following the hot fix or patch deployment, you retain all custom functionality. 

 Deltek strongly recommends that when you upgrade, you first deploy an instance of Vision 
7.1 in your test environment. This allows for functional User Acceptance Testing (UAT) to 
ensure that all mission-critical custom features are still available to the user community. 
Typical deployments call for a 30–45 day test period before upgrading into your production 
environment. 

 

Deltek’s Technical Services team is available to support you as you plan for this upgrade. We 
offer both technical and custom services, ensuring the best possible Deltek experience. Contact 
DGSCONSULTANTS-PES@Deltek.com. 

Custom Programming and Custom Reports 
If you are upgrading to Vision 7.1 from a version earlier than Vision 6.0, and you have developed 
custom programming and/or reports in the earlier versions of Vision: 

 All existing custom programming developed prior to the Vision 6.0 release must be rewritten 
in Smart Client. 

 If you have developed custom reports using the Actuate e.Report Designer, you must 
recreate those reports using Microsoft SQL Reporting Services. Because the SQL Reporting 
Services report designers are much more intuitive than Actuate, you may decide to develop 
new versions of your custom reports on your own. Or, you can contact Deltek for assistance. 

Custom Database Objects 
If you have created any custom objects on your existing Vision database (including custom tables 
and custom triggers), you must review these objects before you upgrade to Vision 7.0 or later 
versions. If you have created custom triggers, you must turn them off before you begin the 
upgrade process, because they might cause the upgrade to fail. 

Vision Screen Designer 
Screen design changes applied in versions prior to Vision 6.0—using the Vision Screen 
Designer—may not display correctly in Vision 7.0 and later versions because Vision now uses 
different font and field sizes than those used in previous releases. Therefore, you should review 
any screens that you previously changed using the Vision Screen Designer and modify them as 
needed. 

mailto:DGSConsultants-PES@deltek.com
mailto:DGSCONSULTANTS-PES@Deltek.com
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Known Issues in Vision 7.1 

Microsoft SQL Server Reporting Services (SSRS) 2008 R2 and Billing 
Invoices 
If you use Deltek Vision 7.1 with Microsoft SQL Server Reporting Services (SSRS) 2008 R2, your 
billing invoices will print with extra space in the header when one or both of the following occur: 

 The top margins for an invoice are expanded. 

 An invoice is configured to have the header start on the second page. This is common when 
a logo or image is included in the header starting on page two. 

This is a known issue with Microsoft SSRS 2008 R2. If you plan to upgrade to Microsoft SSRS 
2008 R2, please carefully review your invoice templates, and wherever possible, reduce the top 
margins using the Vision Invoice Template Editor to prevent the extra space issue from occurring. 

Downgrading to an earlier SQL Server version is not a recommended solution because SQL 
Server 2008 R2 resolved an issue with the summing of calculated field amounts on the total lines 
within reports and invoices. 

IMPORTANT NOTE for Existing Vision Performance Management (DSP) 
Customers: 
If you upgrade your existing Vision installation to Vision 7.1 and you have a Performance Canvas 
URL specified in Weblink, you will receive an HTTP 500 error when you load the Vision 
dashboard. This is a known issue that will be resolved with the first Vision 7.1 hot fix. 

If you have not yet upgraded to 7.1, remove the Performance Canvas URL from all of your 
database entries using the Vision Weblink utility before you upgrade to Vision 7.1. This prevents 
you from receiving the HTTP 500 error. 

If you have already upgraded to 7.1, you must recreate your databases.enc file using the 
following steps: 

1. Ensure that you have all of the information available to recreate your database entries, 
including server names, URLs, user names and password, and other configuration settings.  
We recommended that you take screenshots of all available databases and tabs. 

2. Use Internet Information Services (Administrative Tools) to stop Internet Information 
Services. 

3. In Windows Explorer, browse to the Vision installation directory, and rename the 
databases.enc file to databases.old. 

4. Launch the Vision Weblink utility on the server, and re-enter all of your database and 
configuration information. 

7.1 Online Help 
The online help in Vision 7.1 is the help from 7.0 SP1. The Help is being entirely rewritten using a 
robust new tool that will allow Deltek to update the Help constantly to provide you with the most 
current and accurate information. The new help system will be easier to navigate and use.  

To access the help topics that have been updated and added for the new features in 7.1, see the 
DeltekVision71EnhancementsOnlineHelp.pdf file. You can link to this PDF from the first page 
of the online help, in either of two ways: 

• Click Help » Contents from the top of the Vision screen. 
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• If you are already in the help system, navigate to the first page, “Welcome to the Deltek 
Vision Help System.”  

The PDF is also available on the Deltek Customer Care site from  DSM (Download Software 
Manager) or in Knowledge Base article 74449. 

Google Chrome Frame and the Vision Online Help 

If you have Microsoft Windows XP, Internet Explorer 8 (IE8), and Google Chrome Frame installed 
on a workstation, you will not be able to view the Help that displays in a popup window when you 
click a popup link within a Vision Help topic. To work around this issue, you can uninstall Chrome 
Frame. This allows the popup windows to display correctly in Help. However, if you also use 
Deltek Kona, then when you uninstall Chrome Frame, you must install Google Chrome in order to 
access Kona. 
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For Additional Information 

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web site for Deltek customers who 
purchase an Ongoing Support Plan (OSP). 

The following are some of the many options that the Customer Care Connect site provides: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through 
the Deltek Connect Customer Forums 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 

For more information regarding Deltek Customer Care Connect, refer to the online help available 
from the Web site. 

Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  

1. Go to http://support.deltek.com. 

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you forget your username or password, you can click the Account Assistance button on the 
login screen for help. 

http://support.deltek.com/
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Additional Documentation 
The following is a complete list of documentation that is available for the Deltek Vision 7.1 
release. 

 

Annual Guides 

Starting with the 7.1 release, some of the Vision guides such as the Concepts guide and 
Implementation guide and the Quick Reference Cards (QRCs) will be updated and published 
only once a year at the end of the year instead with each release. The title page of these annual 
guides will refer to 7.x instead of a specific version. The information in these guides will apply to 
the current release at the time that the guides are published. The current release will also be 
noted on the title page of the guide. Any software changes made after the annual guides are 
published will be included in the next annual update. 

Because this is being implemented in the middle of the year, the annual guides will be published 
with the 7.1 release, and their content will apply only for the 7.0 SP1 release. When the guides 
are republished at the end of the year, they will include the 7.1 content. 

 

Vision 7.1 Documentation 

Deltek Vision Getting Started and Concepts Guides 

Deltek Vision Getting Started 
Guide 

This guide contains information about the Vision Web interface and 
all the Vision applications, with tips for navigating through the 
system, using the dashboard, and finding and opening records. 

Deltek Vision Concepts Guide This guide describes the concepts underlying the basic accounting, 
project control, and customer relationship management (CRM) 
functions of the Vision application. 

Deltek Vision Installation and Implementation Guides 

Deltek Vision Technical 
Installation Guide 

This guide contains detailed instructions for installing all the 
technical components of Vision, including the servers, the 
database, and the application itself. 

Deltek Vision Advanced Technical 
Administration Guide 

This guide provides IT staff and system administrators with 
instructions for installing and configuring advanced technical 
components of Vision. 

Deploying Deltek Vision at a 
Hosting Provider 

This guide contains instructions for deploying Deltek Vision at a 
hosting provider. 

Deltek Vision Implementation 
Guide 

This guide contains information about configuring and setting up 
Vision applications and features. 

Deltek Vision Migration Guides 

Deltek Advantage to Deltek Vision 
Migration Guide 

This guide contains information about migrating from Advantage to 
Vision, including the steps in the migration process and an 
overview of Vision features. 

Deltek FMS to Deltek Vision This guide contains information about migrating from FMS to 
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Vision 7.1 Documentation 
Migration Guide Vision, including the steps in the migration process, discussions of 

the key migration decisions, and procedures for verifying the 
converted data. 

Deltek Sema4 to Deltek Vision 
Migration Guide 

This guide contains information about migrating from Sema4 to 
Vision, including the steps in the migration process and an 
overview of Vision features. 

Deltek Vision Quick Reference Cards 

Deltek Vision Quick Reference 
Cards 

Quick reference cards provide snapshots of specific business 
processes or Vision forms, with tips for entering data and using 
application toolbars. The following quick reference cards are 
available: 

 Accounts Payable (Create a Voucher from a Purchase Order) 

 Create Client from Vendor Utility 

 Dashboard 

 Expense Report 

 Navigation Tree Designer 

 Project Planning 

 Purchasing (Create a Standard Purchase Order) 

 Resource Management (Generic Resource Assignments and 
Resource Utilization) 

 Screen Designer 

 SF330 Proposals 

 Template Based E-mails 

 Timesheet 

 User Options 

 Visualization 

Deltek Vision Document Management Guide 

Deltek Vision Document 
Management Installation Guide 

This guide contains detailed information on the necessary 
prerequisites, general configuration, and installation procedures 
required to use the Vision Document Management application. 

Deltek Vision Interface to Microsoft Project 

Deltek Vision Interface to 
Microsoft Project 2010 

This guide describes how the manual scheduling feature in 
Microsoft Project 2010 impacts the two-way interface between 
Deltek Vision and Microsoft Project 2010. 

Deltek Vision Performance Management Guides (Analysis Cubes and Performance 
Dashboards) 

Deltek Vision Installation Guide This guide provides instructions on how to install and configure the 
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Vision 7.1 Documentation 
for Performance Management 
(Analysis Cubes and Performance 
Dashboards) 

following components of the Deltek Vision Performance 
Management module: 

 Analysis Cubes 

 Performance Management Dashboards 

Deltek Vision Performance 
Management Content and 
Functionality Overview 

This guide provides an overview of Vision Performance 
Management functionality and the pre-built visualizations that are 
included with it. 

Tableau Server 8.0 Administrator 
Guide 

This administrator guide, produced by Tableau Software, Inc., is a 
complete reference for handling administrative tasks on Tableau 
Server. Use Tableau Server and Tableau Desktop, along with 
Vision Analysis Cubes and Microsoft SQL Server Analysis 
Services components, to create role-based graphical performance 
dashboards.  

Deltek Vision Reporting Guides 

Deltek Vision Custom Reports 
and Microsoft® SQL Server 
Reporting Services 

This guide provides instructions to create, deliver, and generate 
Vision custom reports with Microsoft SQL Server Reporting 
Services and its report writing tools. 

Deltek Vision Microsoft SQL 
Server Reporting Services 
Licensing FAQ 

This guide explains the Microsoft SQL Server Reporting Services 
licensing implications for Vision. 

Deltek Vision Connect for Microsoft Outlook Guides 

Deltek Vision Connect for 
Microsoft Outlook Installation 
Guide 

This guide contains an overview of Vision Connect for Microsoft 
Outlook, as well as technical installation, setup, and maintenance 
information. 

Deltek Vision Customizing 
Configuration Settings for 
Connect for Microsoft Outlook 

This guide was formerly named Deltek Vision Connect for 
Microsoft Outlook Presets Configuration Guide. 

The guide is intended for system administrators, IT staff, or custom 
developers. It provides instructions on how to create presets to: 
configure default behavior for converting Microsoft Outlook 
contacts; control the display of the Synchronization Control Panel 
when issues occur during synchronization; and implement default 
and custom synchronization filters. 

Deltek Vision Connect for 
Microsoft Outlook Frequently 
Asked Questions 

This document contains frequently asked questions (FAQs) on 
topics regarding deployment, customization, environment, usage, 
and functionality. 

 

Deltek VisionXtend Guide 

Deltek VisionXtend Web Services 
and APIs for Deltek Vision 

This guide explains how to use the Deltek VisionXtend platform to 
integrate Vision with other applications, access web services, 
implement data validation routines, and establish workflow 
procedures using the Microsoft .NET Framework. 
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Vision 7.1 Documentation 

Deletk VisionXtend Testing the 
Vision Web APIs / Web Services 

This guide provides basic information about testing Vision APIs 
using soapUI.  

Deltek Vision Project Connect Guides 

Deltek Vision Project Connect 
Installation and Administration 
Guide 

This guide contains detailed information on installing and 
administering Project Connect for integrating Microsoft Project with 
Deltek Vision. 

Deltek Vision Project Connect 
User’s Guide for Microsoft Project 
2010 

This guide contains information for integrating Microsoft Project 
2010 with Deltek Vision. 

Deltek Vision Project Connect 
User’s Guide for Microsoft Project 
2007 

This guide contains information for integrating Microsoft Project 
2007 with Deltek Vision. 

Deltek Vision Navigator Guides 

Deltek Vision Navigator Version 
1.5 Release Notes for Vision 
Versions 7.0 SP1and 7.1 

These release notes contain a summary of the installation 
requirements, enhancements, and software issues resolved in 
Vision Navigator. 

Deltek Vision Navigator Version 
1.5 Installation Guide for Vision 
Versions 7.0 SP1 and 7.1 

This document describes the server prerequisites, client 
requirements, and installation information for Deltek Vision 
Navigator. 

Deltek Vision Navigator Version 
1.5 Integration Guide for Vision 
Versions 7.0 SP1 and 7.1 

This guide contains details on how the Vision application integrates 
with Deltek Vision Navigator and provides descriptions of the 
various changes to the Vision online help. Refer to the topics within 
this guide for the most current information. 

Deltek Vision Navigator Version 
1.5 Frequently Asked Questions 
for Vision Versions 7.0 SP1 and 
7.1 

This document contains frequently asked questions about general 
product details on the use and configuration of the Deltek Vision 
Navigator product. 
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Adding Custom Notes to a Guide or to These 
Release Notes 
If you would like to add custom notes to a guide or these release notes that are specific to your 
company, Adobe® Reader® X provides this ability. If you do not already use Adobe Reader X, you 
can download it here free from Adobe. 

To add a custom note using Adobe Reader X, complete the following steps: 

1. On the Reader toolbar, click Comment at the far right. 

2. In the Annotations pane that displays, click  Sticky Note. The cursor changes to 
match the button. 

3. Position the cursor at the location in the guide where you want the note to appear, and 
click. A note icon is inserted at the location and a text box pops up. 

4. Enter your information in the text box. 

5. Continue adding notes as needed. 

6. Save the document. 

 

Deltek recommends that you save the document to a slightly different filename so as to keep 
the original file from being overwritten. 

When reading the document, cursor over a note icon to see the information. Double-click a note 
icon to edit the information. 

http://get.adobe.com/reader/
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Enhancements 
This section includes summaries of the new enhancements included in this release. 

Adobe InDesign Merge Templates 
You can now create Vision merge templates with Adobe InDesign as an alternative to creating 
merge templates with Microsoft Word. Merge templates are used to create merged documents in 
the Vision Info Centers and in Custom Proposals. Merge templates created with InDesign give 
you more flexibility with formatting and structuring a merged document. 

Prerequisites 
The following are required before you can use Adobe InDesign to create Vision merge templates 
and generate merged documents: 

 You must have InDesign installed on your workstation. 

 InDesign versions CS5.5 (7.5) and later are supported for Vision. InDesign via the 
Creative Cloud solution in not yet supported. 

If you use InDesign CS6, you must install InDesign on the same drive as your Windows 
Users directory on your workstation. If they are not located in the same directory, you 
cannot create or edit Vision InDesign templates. You will receive a message that 
InDesign has never been run as an administrator, and InDesign will not open. This issue 
does not occur with InDesign CS5.5. 

 InDesign must be included in the Windows registry on your workstation in order for it to 
work with Vision. For more information, see the “Create the Adobe InDesign Registry 
Entry” help topic in the DeltekVision7.1Enhancements-OnlineHelp.pdf file. 

You can link to this PDF from the first page of the online help, in either of two ways: 

• Click Help » Contents from the top of the Vision screen. 

• If you are already in the help system, navigate to the first page, “Welcome to the 
Deltek Vision Help System.”  

The PDF is also available on the Deltek Customer Care site from  DSM (Download 
Software Manager) or in Knowledge Base article 74449. 

 You must enable Microsoft SQL Server FILESTREAM because InDesign merge 
templates are uploaded and saved to Vision using FILESTREAM technology. See the 
Advanced Technical Installation Guide for instructions on enabling FILESTREAM. 

Creating Merge Templates 

Configuration » General » Merge Templates 

You create merge templates with InDesign when InDesign is launched automatically from within 
Vision Merge Templates Configuration (Configuration » General » Merge Templates). In the 
same step that you add the merge template to the Vision database, you also create the merge 
template (an InDesign .indt file). This allows the Vision database tables and fields to be available 
within InDesign. 
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Importing InDesign Merge Templates 

You can also import InDesign merge templates into Vision that were created outside of Vision 
using the Import Adobe InDesign Template option when you click Add on the Merge 
Templates grid on the Merge Templates form in Merge Templates Configuration. 

Sample InDesign Merge Templates 

You can download sample InDesign merge templates from the Deltek Customer Care Connect 
site. See Knowledge Base article # 73879. Use these samples to see what InDesign templates 
look like as you learn how to create InDesign merge templates. You can also import sample 
merge templates in Configuration » General » Merge Templates, and then use them to create 
other merge templates. 

Using InDesign Merge Templates to Generate a Merged Document 

Info Centers 

On an Info Center form, when you click the Merge icon on the toolbar to create a merged 
document, the Merge Templates grid in the Merging dialog box form now displays a Type 
column that indicates whether a merge template was created with Word or InDesign. 

Custom Proposals 

In Custom Proposals, when you click the Sections icon on the toolbar to set up sections and their 
merge templates, the Templates Lookup dialog box that opens when you click the lookup icon in 
the Merge Templates column in the Configure Sections dialog box now includes both Word .rtf 
files and InDesign .indt files. 

Billing Invoice Approvals 
Invoice Approvals is a new optional feature that requires Billing invoices to be approved before 
they are accepted and posted. 

This feature allows you to efficiently move draft invoices through the submittal, rejection, 
approval, and acceptance stages to produce final invoices. Electronic alerts are sent 
automatically to the appropriate employees to notify them that the next action in the approval 
process is ready for them to complete. You can enter approval comments for invoices that can be 
shared easily with others. 

Configuration 
You turn on the Invoice Approvals feature on the Miscellaneous tab in Configuration » Billing » 
General. If you have multiple companies in Vision, you must turn on and set up the Invoice 
Approvals feature for each company. 

After you turn on the feature, you complete the following configuration: 

 Set up invoice approval processes in Configuration » Billing » Invoice Approval 
Process. 

You specify: 

 Who, within a project (project manager, principal, and so on), can approve and reject 
submitted invoices. 

 Who will receive alerts when invoices are submitted, approved, rejected, and 
unsubmitted. 
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 How and when alerts are delivered, and the message in the alerts. 

 Specify in a project's billing terms (on the Misc tab) whether or not a project will use 
invoice approvals and which invoice approval process it will use. 

 On the General tab of the Project Info Center, enter the person who is responsible for 
creating the Billing invoices for a project in the new Biller field. 

If you currently use the Vision Screen Designer, you may need to adjust the location of 
the Biller field to fit the screen that you designed. 

 As needed, you can specify on the General tab in User Options a delegate to approve 
invoices in your absence if you are an invoice approver. 

 

You can use the Search and Replace utility (in Utilities » Advanced Utilities) to easily enable 
invoice approvals, update the invoice approval process, and enter the biller for a group of 
projects. 

Processing 
The following menu items have been added to the Billing menu to support the Invoice Approvals 
feature: 

 Invoice Approvals – Use this program to review multiple invoices at a time and approve 
or reject them. 

 Interactive Approvals – Use this program to review and approve or reject individual 
invoices, one at a time. 

To move invoices through the approval process, you: 

 Submit invoices for approval in Interactive Billing or Batch Billing. 

 Preview invoices, review comments, review transaction detail that is associated with 
submitted invoices, and update percent completes in Interactive Approvals or Invoice 
Approvals. 

 Approve or reject invoices in Interactive Approvals or Invoice Approvals. 

 Final accept invoices in Interactive Billing or Batch Billing after they are approved. 

Reports 
The Invoice Approval Report provides an audit trail of comments and the current approval status 
of invoices that go through an approval process. 

Configuration 

General Tab of Plan Settings 
If you use Vision Navigator, the General tab of Plan Settings was updated to allow you to set the 
defaults for various plan settings in Navigator when the Resource Planning module is in use. 
Refer to the Navigator section of these release notes for further information. 

Dashboard Formatting—Use Flat Dashboard Styling 
The General tab of User Options has a new Use flat dashboard styling check box that allows 
you to switch the Dashboard format to a flat style. This style includes a different style of graphics 
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and color selections for the header bar, but you must log out and back into to Vision for your 
changes to take effect. 

Exchange Rates 
Exchange rate fields in Vision now have 10 decimal places instead of 6. 

Expiration Dates for Vision Modules  
Depending on your Vision software license type, each Vision module may have an expiration 
date. After you enter a password for a module in Configuration » Module Activation, the 
Expiration column displays either of the following:  

 n/a — This displays if you have an unlimited license for the module. An unlimited 
license has no expiration date.  

 <date> — This is the expiration date for the module.  

License Expiration Reminder 
A reminder email will be sent to your Vision help desk email address if you entered one in the 
Default Help Desk field on the Email tab in Vision General » System Settings. Also, on the 
Email tab, you must enter the address of your email server. Vision users with an administrator 
type security role will also receive a reminder message when they log on to Vision. 

Frequency of the Reminder 
The expiration reminder email or message for administrators is sent or displayed 14, 10, 7, 5, 4, 
3, 2, and 1 day before the expiration date. 

You also receive a reminder 30 days before your license expires if the license is a temporary 
license that provides more than 30 days of software use. 

What Happens When Your License Expires 
When the license for a module has expired, the following occur: 

 In Vision Configuration » Module Activation, the License column on the Module 
Activation form displays Expired for the expired module. 

 The menu item for the module does not display in the Vision Navigation menu. 

 The module does not display anywhere in Vision Security » Roles. 

How to Renew an Expired License 
Contact your Deltek account manager to renew the license for a module. 

Export to Text Feature Supports SEPA XML File Formats 
The Vision Export to Text feature, which allows you to create text (.txt) files for Accounts Payable 
and Employee Expenses payments, now supports the Single Euro Payments Area (SEPA) .xml 
file format that is commonly used in the Netherlands. 

The following new items have been added to Vision to support the new SEPA feature: 

Area of the Software New Items 

http://camqasvr08wsx64/vision/Help/en-US/cf_email_tab.htm
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Area of the Software New Items 

Banks Configuration • On the Bank Codes tab, SEPA has been added to the 
drop-down list in the Export to Text Format field. 

• A new SEPA File Format tab has been added to the Bank 
Codes form. 

Employee Info Center The Accounting tab has a new SEPA section with two new 
fields—IBAN and BIC—for the employee’s bank account. 

Vendor Info Center The Accounting tab has a new SEPA section with two new 
fields—IBAN and BIC—for the vendor’s bank account. 

Accounts Payable Payment 
Processing 

and 

Employee Expense Payment 
Processing 

On the Check Printing and Numbering form in Accounts 
Payable Payment Processing and Employee Expense 
Payment Processing, when you click the Export to Text 
button for a bank making the SEPA payments, a dialog box 
displays to allow you to create the SEPA export file. You can 
save or open the file, which is an .xml file. 

Grid Export to Microsoft Excel in .XLSX Format 
In previous versions, when you exported the contents of grids to Excel, the export process 
created an .XLS file. However, that file format had an upper limit of 65,000 grid rows. To avoid 
that limitation, the export process now creates the Excel file in the .XLSX format. 

As a result of this change, you cannot open the export file with older versions of Excel that are not 
compatible with the .XLSX format. You must have Excel 2007 or Excel 2010. (Though Vision no 
longer supports Microsoft Office 2003, you may also be able to open .XLSX files with Excel 2003 
if you have installed the Microsoft Office Compatibility Pack.) 

Kona 
If you are using the Deltek Kona application, the following features are available within Vision. 

User Options 
The Misc tab of Vision User Options includes  Kona Username and Kona Password fields. Use 
these fields to record your Kona username and password. This allows you to open Kona directly 
from within the Vision application. 

If your Kona credentials are not entered in User Options, you must enter your Kona credentials 
when you launch the Vision application using the Kona global icon and the Info Center 
functionality described below.  

Kona Global Icon 

A Kona icon  displays on the toolbar of Vision’s main screen. Click this icon to open the 
Kona application directly from within Vision. If the current project is associated with a Kona space, 
the associated Kona space opens automatically. 
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Info Centers 
The General tabs of the Project and Opportunities Info Centers now include a Kona Space 
option. Use this option to associate a Kona space with the selected project or opportunity. The 
Kona space’s image displays. You can select the space to open Kona directly from within Vision. 

Navigator 
If you use Vision Navigator, the following updates apply to your Vision application. 

Toolbar 

The Navigator icon  displays on the toolbar of Vision’s main screen. Click this icon to 
open the Vision Navigator application from within Vision. If the current project is associated with a 
Navigator plan, the plan opens automatically in Navigator. If Navigator is not installed or 
configured, an error message displays. 

Configuration 
The General tab of Plan Settings has been updated to allow you to set the defaults for various 
plan settings for Consultant Planning in Navigator when the Resource Planning module is in use. 
These consultant settings are Enable Planning tabs/Consultants and Consultant Plan Level.  
Consultant Plan Level is a new field and is only used by Navigator.   

On the Rates tab of Plan Settings, the Calculate Consultant Billing Amounts, Consultant Rate 
Method, Rate Table, and Multiplier options are now also the defaults for Navigator. With the 
exception of Consultant Plan Level, all of these default settings for Consultants are used by 
both Project Planning and Navigator. Consultant Plan Level is only used by Navigator.  

When the Resource Planning module is not in use, new fields were added to Plan Settings for 
Consultant Planning in Navigator. These new fields include Enable Consultants Planning, 
Consultants Plan Level, Consultant Rates: Calculate Consultant Billing Amounts, Rate 
Method, Rate Table, and Multiplier.  

Security 
A new Navigator tab was added to Security Roles Configuration (Configuration » Security » 
Roles). This tab allows a system administrator to configure a role's access rights to the Vision 
Navigator application. This includes the ability to log in to Navigator and to access the Project 
Management and Employee workspaces and their various features. 

In addition, this tab provides the ability to define record level access for Navigator projects and 
plans. Use the Record Level View and Record Level Update fields to access lookups that 
enable you to build queries that grant or restrict different levels of access for Navigator projects 
and plans.  

When you install Vision 7.1, this tab is automatically configured to grant each role the same 
access rights to Navigator that the role had before the installation. 

Performance Management 

Performance Management Dashboards 
For those who purchase Vision Performance Management (VPM), Vision 7.1 adds a completely 
redesigned suite of sample performance dashboards. Performance dashboards are business 
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intelligence tools that executives and managers use to view and interact with critical 
organizational performance data using a variety of graphical representations of that data. 

The sample performance dashboards provide out-of-the-box visualizations of your Vision 
Analysis Cubes data. However, you are not limited to the sample dashboards. VPM also includes 
a new dashboard authoring tool from Tableau Software that enables you to modify the sample 
dashboards or to create and deploy dashboards that you design yourself. 

Sample Performance Dashboards 

The 38 sample performance dashboards provided in Vision 7.1 are divided into sets that are 
designed for the following specific management and responsibility roles in your firm: 

 Business development manager 

 Executive 

 Finance 

 Organization manager 

 Principal 

 Project manager 

 Resource manager 

Many of the dashboards include automatically applied filters so that when you display them, the 
charts and tables only present data that is relevant to you. For example, if you display one of the 
organization manager dashboards, the dashboard, by default, only includes data for the 
organization to which you are assigned in Vision. And all of the sample performance dashboards 
offer multiple options for filtering and drilling into the data. 

While you can use the sample performance dashboards as they are, they are also valuable as 
examples of the capabilities of performance dashboards and as starting points for building your 
own dashboards. 

Dashboard Access 

Vision users can add published performance dashboards—both sample dashboards and 
dashboards that you create—as Web dashparts to their Vision Dashboard, or they can display 
them from Vision Reporting in the standard Preview window. 

You can also make the dashboards available to users from outside Vision, through a browser, for 
example, or on supported mobile devices. 

To support collaboration, all of the dashboards offer options for saving, sharing, and distributing 
key views of the data. 

Dashboard Authoring 

Those in your firm who are interested in exploring your Vision Analysis Cubes data in new ways 
can use Tableau Desktop to design and build their own dashboards. Tableau Desktop is an 
extremely flexible and intuitive authoring tool, ideal for trying out innovative approaches to data 
analysis. The dashboards created with Tableau Desktop can be strictly for the author’s own use, 
or they can be published and made available to others who use VPM. Your VPM license includes 
full access to Tableau Desktop for any number of users. 

Additional Changes to Support the Performance Dashboards 

To support the new performance dashboards, some additional changes to existing Vision 
applications were necessary. 
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Resource Kit: New Performance Management Tab 
To support the new performance dashboards in Vision Performance Management, a 
Performance Management subtab has been added to the Database tab in the Vision Resource 
Kit. Use the options on that tab to do the following: 

 Specify configuration settings for Tableau Server. 

 Select one or two organization levels by which you want to filter the performance 
dashboards that are designed to be filtered by organization. 

 Publish Tableau workbooks that contain new or updated performance management 
dashboards. 

 Apply the Vision Analysis Cubes KPIs to the template workbook so they are available as 
calculated members in new workbooks that you create based on the template. 

 Export Vision users so you can import them into Tableau Server to set up dashboard 
access and security for Vision Performance Management users. 

Analysis Cubes Configuration: Option to Restore Required Configuration Settings 
The sample performance dashboards in Vision Performance Management require that the 
Analysis Cubes include a specific set of dimensions, measures, and KPIs. If one of those 
required data items has been removed from the Analysis Cubes, you may receive errors when 
you try to publish or display the sample dashboards or your custom dashboards that are based 
on those sample dashboards. 

If you receive an error when you publish or display a dashboard, and the message indicates that 
required data is missing from the Analysis Cubes, click  Restore Required Configuration on 
the toolbar on the Analysis Cubes form (Configuration » General » Analysis Cubes) to restore 
all of the dimensions, measures, and KPIs that the performance dashboards need. You must also 
reprocess the Analysis Cubes to apply the updated configuration. 

 

This option is available only if you have activated the Performance Management edition of the 
module. If you have only activated the Performance Management Analysis Cubes edition, it is 
not displayed. 

System Labels: Reminder to Reprocess Analysis Cubes after Changes 
When you change a system label on the Label tab of the General System Settings form 
(Configuration  » General » System Settings), Vision now displays a warning that you may 
receive errors when you display the sample performance dashboards if you do not also use the 
Resource Kit to apply the updated labels to the Analysis Cubes and republish all of the 
performance dashboards that access those Analysis Cubes. 

This message only displays if the Performance Management edition of Vision Performance 
Management is activated. It is not displayed if the Performance Management Analysis Cubes 
edition is activated or if neither edition of Vision Performance Management is activated. 

Vision Dashboard: Removal of Dashparts for Old Performance Dashboards 
If you implemented the performance dashboards in earlier versions of Vision, the upgrade 
process for Vision 7.1 removes all Web dashparts that were created to display those old 
performance dashboards on the Vision Dashboard. 
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Photo Upload   

The Project Info Center toolbar and the Opportunity Info Center toolbar now include a  Photo 
button. Click this button to access the Photo Upload dialog box, and add a photo to a project or 
opportunity record. 

Project Info Center List View—Populated with Phase and Task 
Records  
The following additions have been implemented in Vision to allow you to populate the List View in 
the Project Info Center with phase and task records (work breakdown structure (WBS) level 2 and 
3). 

Advanced Project Lookup Dialog Box in the Project Info Center 

This applies for the Advanced Project Lookup dialog box only in the Project Info Center. 

On the Advanced Project Lookup dialog box use the Display field to select whether to populate 
the List View or Detail View of the Project Info Center with project, phase, task, or all records. 

The search results list at the bottom of the dialog box now displays phases or phases and tasks 
depending what you selected in the Display field before you clicked the Search button. 

When you click the Select All button or select some of the records in the search results list and 
then click the Select button, the List View or Detailed View is populated with the records that you 
selected. 

List View in the Project Info Center 

The Projects grid in the List View of the Project Info Center now includes the following additional 
columns by default: Phase Name and Task Name. You can removed these using the Select 
Fields option on the Projects grid toolbar. 

You can manually add the Phase (phase number) and Task (task number) columns to the 
Projects grid using the Select Fields option on the Projects grid toolbar. 

Report Administration: Option to Delete Archived Reports 
Vision automatically deletes archived reports based on the number of archive hours specified 
when each archived report is generated. Now, however, you can also use the Report 
Administration utility (Utilities » Report Administration) to delete archived reports. 

The grid under Report Archives on the Database Cleanup tab lists all archived reports that 
currently exist in Vision. Displayed for each report are 

 Username of the person who created the archived report 

 Type of report 

 Report name 

 Date the archived report was created 

 Date and time that Vision will automatically remove the archived report 

You can use the Report Archives That Are Older Than This Number of Days field to restrict 
the list to the older archived reports. To delete an archived report, select the grid row for the 
report and click Delete. 
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This addition to the Report Administration utility is also useful as a way to monitor, in one location, 
the system-wide accumulation of archived reports. Before, you had to display the list of archived 
reports for each report type individually in Vision Reporting. 

Reporting 

Preview Window Updated 
Deltek upgraded the software underlying the report preview window. For the most part, the new 
version functions exactly the same as the prior one, but a few differences exist: 

 This upgrade resolves some HTML display defects in the earlier version. 

 How you display the document map has changed. Now you click the bar on the left edge 
of the Preview window to display the document map. 

 
Click the similar bar on the right edge of the document map pane to hide the document 
map. 

 How you display the parameter area has changed. Now you click the bar on the top edge 
of the Preview window toolbar to display the parameter area. 

 
Click the similar bar at the bottom edge of the parameter area to hide the parameter area. 

Roles Summary Report 
For Vision Navigator users, the Roles Summary report now includes a Navigator option in the 
Report Sections to Include group box. 

Turn HTML Formatting On or Off for Report Memo Fields 
If you include a column for a memo field on a report and you do not want to apply HTML 
formatting (bold, underlining, colors, and so on) to the contents of the column based on the 
formatting applied when the text was originally entered in each memo field, you can turn off the 
HTML formatting for that report column using the HTML grid column on the Columns tab of the 
report’s Options dialog box. If you clear the check box in that grid column, the report displays the 
text without any special formatting. You may want to do this if, for example, the formatting was 
applied inconsistently during data entry or the formatting is unsatisfactory for some other reason. 

For reports that do not have the option to select report columns, you can use the new HTML 
Formatting check box on the Layout tab of the report’s Options dialog box to turn off or on HTML 
formatting for all memo fields on the report. 

Tax Analysis 
The Tax Analysis report was updated to support the ability to run on Vendor Selection criteria. 
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Web Dashpart 
The Web dashpart includes a new Hide Toolbar option to hide the Reporting toolbar on the web 
dashpart. This is useful for providing extra space on reports that contain graphs. You must reload 
the Dashboard for the change to take effect. 

Security Configuration 

Password Policies 
The Password Policies feature is now separate from the Users application. Use Password 
Policies Security to establish policies that dictate the criteria for acceptable Vision passwords. 
These policies apply when users change their own passwords, which they can do after the initial 
log in. These policies do not apply to the Password field on the Users tab. 

Roles 
The Roles application of Vision Security Configuration was updated as follows: 

General Tab  

The General tab includes a Force User to Reset Password at Next Login option that forces the 
user to reset their password the next time they log in. When this option is selected, the following 
occurs: 

 The Vision Welcome screen displays with an active Change Password dialog box. 

 The Cancel and Exit buttons are disabled. 

The user must complete the fields on the Change Password dialog box and click OK. The 
password is reset and the Force User to Reset Password at Next Login option is no longer 
selected upon logging in. 

Navigator Tab 

A new Navigator tab was added to Vision Roles in Vision 7.1. When you install Vision 7.1, this tab 
is automatically configured to grant each role the same access rights to Navigator that the role 
had before the installation. 

Record Access Tab 

The Record Access tab includes the following new options: 

 Allow modification of Disable Login user setting in Users when read-only access —
Select this option to give users in this role access to modify the enable/disable login user 
setting when they only have read-only access to the Users application. 

 Allow modification of Passwords in Users when read-only access — Select this option 
to give users in this role access to modify user passwords even if they only have read-only 
access to the Users application. 

Users  
Vision Security Configuration now includes a Users application. This feature functions like an Info 
Center, and allows you to create, update, and manage user information in one location. The 
feature includes the following tabs: 

 General tab — Use this tab to create a username for an employee, assign the user to a 
security role, force a user to change their password at a specific time, and set up default 



Enhancements 

 

Release Notes 31 

 

report settings for the user. You cannot exceed the number of users that you are licensed to 
set up.  

 Generate Users tab — Use this tab to create Vision users from employee records in the 
Employee Info Center. This is helpful when you need to create many users at one time.  You 
cannot exceed the number of users that your firm is licensed to set up.  

Transaction Auto Numbering  
The new Transaction Auto Numbering tab in Configuration » Accounting » System Settings 
allows you to set up auto numbering for your Vision transactions. When auto numbering is 
enabled, Vision automatically generates a reference number for each transaction. These 
reference numbers can be sequential as you add transactions to your database, and you can 
define the structure of these identification numbers to match your firm's business requirements.  

Auto numbers can be set up by company and/or by bank. When autonumbers are in use and you 
create a new record, [AUTONUMBER] displays in the following field types for the record: 
Reference or Check. 

Transaction Document Management (TDM) 
Transaction Document Management (TDM) is a new feature that allows you to attach documents 
in support of accounts payable vouchers and employee expense reports. You can select 
individual documents for each transaction or choose to have a document apply to all lines in an 
accounts payable voucher or employee expense report. Supported file types include image files, 
.pdfs, Microsoft Word documents, and Microsoft Excel spreadsheets. These supporting 
documents are then integrated with the Vision billing system and are exposed and available as a 
part of the invoicing process.  

TDM Configuration 
TDM uses FILESTREAM functionality, a native Microsoft SQL Server feature, to store supporting 
documents. TDM is configured through the Microsoft SQL Server configuration and is enabled in 
the Vision Weblink Utility by selecting the Enable Transactional Document Management 
option. See the Advanced Technical Installation Guide for instructions on enabling FILESTREAM. 

Vision also includes a new Files Administration utility where you can search for and view the 
supporting documents that were uploaded for transactions and confirm that the files between the 
Vision and FILESTREAM databases are synchronized.  

Utilities 
The Search and Replace Advanced Utility was updated to remove the CA.Type field from the 
Available Change list. 

Vision Login Password/User ID Reminder 
The Vision login dialog box includes a Password and User ID reminder option. Select this option 
to reset your Vision password or receive a reminder of your User ID in the event that they are 
forgotten. 
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Weblink Utility 

Database List View Tab 
The Database Grid View tab has been renamed. It is now the Database List View tab. 

The Up and Down toolbar options for the grid on this tab have been renamed to Move Up and 
Move Down. Use these buttons to control the order of the databases listed in the grid. This order 
can control the order of the databases in the drop-down list in Deltek Vision Login dialog box, but 
only if you complete the additional steps to modify the web.config file. For instructions on how to 
modify this file, see the help topic titled “Modify the Web.config File to Add the Vision Database 
Sort Order.” If you do not modify the web.config file, the order of the databases in the drop-down 
list in the Deltek Vision Login dialog box is alphabetical by database description. 

Document Management Tab 
To provide a more logical organization of Weblink options, Deltek added a new Document 
Management tab and moved the Document Management options from the System Settings tab 
to the new tab. 

General Tab 

SaaS / Hosted Instance Check Box 

When you select the SaaS / Hosted Instance check box in the Configuration section on the 
General tab, the Number of days to retain audit history field in the Info Center Audit Trail 
section on the Audit Trail tab in Configuration » General » System Settings, allows a value of 
only 30 or less. 
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Software Issues Resolved Since Vision 7.0 SP1 
This section includes summaries of the software issues resolved since the Vision 7.0 SP1 
release. For summaries of the software issues that were resolved in the 7.0 SP1 hot fixes since 
the 7.0 SP1 General Availability release, see “Appendix A: Vision 7.0 SP1 Hot-Fixed .” These 7.0 
SP1 hot-fixed items are also fixed in 7.1. 

Descriptions of Software Issues 
You will notice that the descriptions of some software defects contain extra information, including 
ways to work around the defects. For the most part, these issues were addressed before this 
release through hot fixes, and the additional information was developed to help you decide 
whether or not you needed to install the hot fixes. 
 

Accounting 
 

Accounts Payable  

Vendor Review  

 Deltek Defect Tracking Number: 341661 

 Description: On the Vouchers tab in Vendor Review, tax amounts were omitted 
from the amounts in the voucher Amount and Balance columns after you 
change the payment currency on the Voucher Details dialog box. 

Customers Impacted: This defect applies to Vision 7. 0 and later releases. 

Workaround Before Fix: Unpost the Accounts Payable voucher file in Vision. 
Before you unpost it, make sure that the payment currency is the same as when 
it was originally posted. 

Additional Notes: None. 

   

Intercompany Billing  

 Deltek Defect Tracking Number: 257616 

 Description: Vision did not generate an intercompany invoice when the net 
amount in the billing currency was zero but the underlying functional currency 
amount was non-zero. The missing subledger AR entry caused an out-of-balance 
condition. 
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Customers Impacted: This issue applies to Vision 6.1 SP3 and later versions. 

Workaround Before Fix: In Intercompany Billing, process the transaction 
postings that net to zero separately. 

Additional Notes: None. 

   

 Deltek Defect Tracking Number: 257617 

 Description: When an Intercompany billing invoice amount was non-zero and the 
underlying functional amount should have been zero, the functional amount was 
not zero. 

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround: In Intercompany Billing, process the transaction postings that net to 
zero separately, so that the “net zero” case does not occur. 

Additional Notes: None. 

   

Void Check  

 Deltek Defect Tracking Number: 368477 

 Description: When a posting contained checks and EFT payments and the EFTs 
were cleared in Bank Reconciliation, the checks did not display in Void Check 
Processing. 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: Temporarily unclear the EFT in Bank 
Reconciliation. Void the check, and then clear the EFT again in Bank 
Reconciliation. 

Additional Notes: None. 

   

Architecture 
 

 Deltek Defect Tracking Number: 365314 



Software Issues Resolved Since Vision 7.0 SP1 

 

Release Notes 35 

 

 Description: When you attempted to use an SSL termination device, you received 
a connection refused error on port 443 (SSL) and were unable to run reports. The 
existing Vision architecture was sending SSL requests to the report server, which 
does not have an SSL certificate installed. 

Customers Impacted: This defect applies to Vision 6.1 SP4 and later defects. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Billing 
 

 Deltek Defect Tracking Number: 341829 

 Description: Using the Vision Text Editor to edit the Description in Billing Terms 
resulted in an unwanted space on the associated invoice. This occurred when 
pressing the Enter key, which added  unwanted <p> </p> HTML tags.  

Customers Impacted: This issue applies to Vision 7.0 SP1 and later.  

Workaround Before Fix: Copy and paste the description into Notepad, and the 
delete the description from Billing Terms. Save Billing Terms. and then use the 
Edit button and paste or type the description back in (do not press Enter).  

Additional Notes: If you use the Text Editor and do not press Enter, you will not 
have an issue.  When you press Enter, the <p> </p> html tags get added and 
cause the space on the invoice.  (If you delete the carriage return these paragraph 
tags remain.) 

   

Interactive Billing  

 Deltek Defect Tracking Number: 367989 

 Description: An error occurred when you previewed invoices from Japanese 
currency projects (that have zero decimal places) if the rate required rounding. 

Customers Impacted: This defect applies to Vision 6.2 SP2 and later versions. 

Workaround Before Fix: Modify the billing rate table to not use precision that 
would need rounding to the whole number. For example, if you change the rate of 
9983.9 to 9984, that would fix the problem. 
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Additional Notes: None. 

   

 Deltek Defect Tracking Number: 260592 

 Description: If you used a font other than the default font (Arial) and you sent 
invoices directly to the printer rather than previewing them and printing from the 
preview window, the print quality was blurry. 

Customers Impacted: This defect applies to Vision 6.2 SP2 and later versions. 

Workaround Before Fix: Preview the invoice and then print it from the preview 
window. 

Additional Notes: None. 

   

Calendar 
 

 Activities  

 Deltek Defect Tracking Number: 369471 

 Description: When you created a new activity and attached a PDF file from the  
Deltek database to email to employees, when you clicked Send, you received an 
error. 

Customers Impacted: This defect affects Vision Essentials -- SaaS 7.0 and 
later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Activity Manager  

 Deltek Defect Tracking Number: 365048 

 Description: When you set up a monthly recurring activity, you received 
the following error "You have chosen a recurring pattern that does not fit the start 
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date." 

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Connect for Microsoft Outlook 

 Deltek Defect Tracking Number: 263062 

 Description: User-defined memo fields (Type = Memo) prevented Connect for 
Microsoft Outlook from synchronizing.  

Customers Impacted: This defect applies to Vision 6.2 SP2 and later Connect for 
Microsoft Outlook users. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Configuration 
 

General  

Alerts  

 Deltek Defect Tracking Number: 256624 

 Description: When you entered an alert with special characters such as a tilde (~), 
the special character did not display correctly in email notifications that were sent 
for the alert. 

Customers Impacted: This defect applies to Vision 6.1 SP4 and later.  

Workaround Before Fix: None. 

Additional Notes: None. 
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Organization  

Individual  

 Deltek Defect Tracking Number: 364318 

 Description: In Configuration » Organization » Individual, the labels on the 
Gains and Losses tab were missing. 

Customers Impacted:  This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Security  

 Deltek Defect Tracking Number: 367584 

 Description: You were unable to select multiple employees in the User Lookup 
dialog box that opens from the following location: 

• Click Configuration » Security » Roles, and open the Record Access 
tab. 

• In the Activity Access section, select Use Query in the Record Level 
View field. 

• In the unlabeled field to the right of the Record Level View field, click the 
Find icon to open the Activities Filter dialog box. 

• In the View by Association grid, click the Find icon in the Records 
column for the Created By type of association. 

• In the User Lookup dialog box, select Employee in the Search By field, 
and then click the Search button.  

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: Manually type the list of employees. 

Additional Notes: None. 
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Human Resources 
 

Export to PayChex  

 Deltek Defect Tracking Number: 366218 

 Description: The process for exporting timesheets to ADP was slow. 

Customers Impacted: This issue applies to Vision 6.1 SP4 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Payroll  

Quarterly Processing  

 Deltek Defect Tracking Number: 366385 

 Description: The quarterly processing file for New York was missing the count of 
1E records in Record 1F-Final Record in Human Resources » Payroll 
» Quarterly Processing. 

Customers Impacted: This issue applies to Vision 7.1 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Info Center 
 

 Deltek Defect Tracking Number: 367545 

 Description: User-defined fields were missing from reports when a user-defined 
field had a value list, but it was not limited to that list and the value of items in that 
list had been changed.     
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Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: Delete and re-add the user-defined field code and 
description so the value matches the code.  Or, switch to Grid View and download 
to Excel.  

Additional Notes: None. 

   

Login 
 

 Deltek Defect Tracking Number: 369164 

 Description: An employee who was terminated was able to gain access to the 
Vision using the Forgot your password or User ID? link on the Deltek Vision 
Login screen.  

Customers Impacted: This defect applies to Vision 7.1 Beta. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Purchasing 
 

 Deltek Defect Tracking Number: 366238 

 Description: The Purchase Order would not close when the First Name or Last 
Name fields were blank. Vision displayed a Required field, data must be 
entered message.   

Customers Impacted: This issue applies to Vision 6.1 SP4 and later versions.  

Workaround Before Fix: Fill in the First Name fields.  

Additional Notes: None. 
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Reporting 
 

 Deltek Defect Tracking Number: 372130 

 Description: When you scheduled reports to run on the process server, the 
reports failed with this error: "The given key was not present in the dictionary." 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

 Deltek Defect Tracking Number: 266624 

 Description: Customers experienced assorted printing problems, including the 
following: option to print multiple copies not working, blurry text, lines printing 
thicker than normal and slow printing on WANs. 

Customers Impacted: This defect applies to Vision 6.2 SP2 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Accounts Receivable  

 Deltek Defect Tracking Number: 351479 

 Description: The statement date on the AR Statement report was printing higher 
on the page.  

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: Increase the top margin on the Layout tab. This moves 
the report contents down.  

Additional Notes: None. 
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Billing  

 Deltek Defect Tracking Number: 255260 

 Description: The Fee Remaining report displayed incorrect amounts in Previous 
Fee and Fee Amount if the project's fee billing terms were not set up at the WBS 
level to which the fee amounts were posted and if Enter Prior Fee Billing in 
Billing Terms was not selected on the Miscellaneous tab of the Billing Setup form 
so that previous fee amounts could be entered on the Billing Terms form. 

Customers Impacted: This defect applies to Vision 5.0 and later versions. 

Workaround Before Fix: Select Enter Prior Fee Billing in Billing Terms, and 
enter previous fee amounts on the Billing Terms form. 

Additional Notes: None. 

   

 Deltek Defect Tracking Number: 255491 

 Description: If the billing terms for a project included a labor category table 
override, the Unbilled Detail report correctly listed the override billing rates but 
listed the original labor categories rather than the override labor categories in the 
Labor Category column. 

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Project  

 Deltek Defect Tracking Number: 263995 

 Description: The Project Summary report had incorrect JTD Revenue amounts 
when you ran the report without expenses. 

Customers Impacted: This defect applies to Vision 5.1 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 
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Resource Kit 
 

 Deltek Defect Tracking Number: 373506 

 Description: You received an error in the Vision Resource Kit when you opened 
the Web/Application Server tab, opened the Web.config sub-tab, and then 
changed AllowFileSave to Y. 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: Manually make the change in the web.config file. 

Additional Notes: None. 

   

Utilities 
 

Advanced Utilities  

Data Import  

 Deltek Defect Tracking Number: 368282 

 Description: When you processed an A/P Voucher Data Entry import, you 
received the following error: "Invalid match of Currency Code EUR and Bank 
Account Currency Code USD."  

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: Enter the data directly into Vision. 

Additional Notes: None. 

   

VisionXtend 
 

 Deltek Defect Tracking Number: 374001 
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 Description: If you use VisionXtend APIs, custom fields were not returned 
with the GetSchema method. 

Customers Impacted: This defect applies to VisionXtend 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 
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Database Changes 
This section lists the database table and column changes included in this release. 

 

Deltek creates the Vision Data Dictionary using a live connection to the Vision development 
database. Tables and columns related to features in a future release may appear in the data 
dictionary without descriptions, or with the phrase reserved for future use. You may also see 
tables and columns for features you have not purchased or enabled. 

New Tables 

Table Name 

APDocuments 

APDocumentsDetail 

CFGBillApprovalActionAlerts 

CFGBillApprovalActions 

CFGBillApprovalData 

CFGBillApprovalDescriptions 

CFGMobileCRMSections 

CFGTransAutoNumBank 

CFGTransAutoNumType 

EKDocuments 

EKDocumentsDetail 

FW_Files 

FW_PerfManagement 

FW_Workbook 

FW_WorkbookFilters 

InvoiceApproval 

InvoiceApprovalActions 

LedgerDocuments 

OpportunityPhoto 
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Removed Tables 

Table Name 

CFGDSPURL 

Renamed Tables 
No tables were renamed. 

New Columns Added to Existing Tables 

Table Name Column Name DataType 

apppChecks SEPAIndicator varchar(1) 

BIED InvoiceStatus varchar(1) 

BILD InvoiceStatus varchar(1) 

BT InvoiceApprovalCode varchar(10) 

BT InvoiceApprovalEnabled varchar(1) NOT NULL 

BT SupportDocuments varchar(1) NOT NULL 

BT SupportDocumentsAP varchar(1) NOT NULL 

BT SupportDocumentsBkupRpt varchar(1) NOT NULL 
default ('Y') 

BT SupportDocumentsEX varchar(1) NOT NULL 

BTDefaults InvoiceApprovalCode varchar(10) 

BTDefaults InvoiceApprovalEnabled varchar(1) NOT NULL 

BTDefaults SupportDocuments varchar(1) NOT NULL 

BTDefaults SupportDocumentsAP varchar(1) NOT NULL 

BTDefaults SupportDocumentsBkupRpt varchar(1) NOT NULL 
default ('Y') 

BTDefaults SupportDocumentsEX varchar(1) NOT NULL 

CFGBanks SEPAAddress1 varchar(70) 

CFGBanks SEPAAddress2 varchar(70) 
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Table Name Column Name DataType 

CFGBanks SEPABIC varchar(35) 

CFGBanks SEPACountry varchar(2) 

CFGBanks SEPAFormat int NOT NULL default (0) 

CFGBanks SEPAIBAN varchar(35) 

CFGBillMain DefaultInvoiceApprovalCode varchar(10) 

CFGBillMain InvoiceApprovalEnabled varchar(1) NOT NULL 

CFGEKMain ShowSeqNumber varchar(1) NOT NULL 
default ('N') 

CFGResourcePlanning ConWBSLevel smallint NOT NULL 
default (3) 

CR SEPAIndicator varchar(1) 

CR StatementNumber varchar(12) 

EM SEPABIC varchar(35) 

EM SEPAIBAN varchar(35) 

EM TaxRegistrationNumber varchar(15) 

EMInitiation SEPABIC varchar(35) 

EMInitiation SEPAIBAN varchar(35) 

EMInitiation TaxRegistrationNumber varchar(15) 

exChecks SEPAIndicator varchar(1) 

FW_CustomNavTreeData Icon varchar(255) 

ICBillingWK AmountBillingCurrency decimal(19,4) NOT 
NULL default (0) 

ICBillingWK CashBasisSubledgerTrans varchar(1) NOT NULL 
default ('N') 

ICBillingWK LabComment varchar(max) 

ICBillingWK RealizedGainsCreditAccount varchar(13) 
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Table Name Column Name DataType 

ICBillingWK RealizedGainsCreditWBS1 varchar(30) 

ICBillingWK RealizedGainsCreditWBS2 varchar(7) 

ICBillingWK RealizedGainsCreditWBS3 varchar(7) 

ICBillingWK RealizedGainsDebitAccount varchar(13) 

ICBillingWK RealizedGainsDebitWBS1 varchar(30) 

ICBillingWK RealizedGainsDebitWBS2 varchar(7) 

ICBillingWK RealizedGainsDebitWBS3 varchar(7) 

ICBillingWK RealizedLossesCreditAccount varchar(13) 

ICBillingWK RealizedLossesCreditWBS1 varchar(30) 

ICBillingWK RealizedLossesCreditWBS2 varchar(7) 

ICBillingWK RealizedLossesCreditWBS3 varchar(7) 

ICBillingWK RealizedLossesDebitAccount varchar(13) 

ICBillingWK RealizedLossesDebitWBS1 varchar(30) 

ICBillingWK RealizedLossesDebitWBS2 varchar(7) 

ICBillingWK RealizedLossesDebitWBS3 varchar(7) 

ICBillingWK ReclassAsGainLoss varchar(1) NOT NULL 
default ('N') 

LD InvoiceStatus varchar(1) 

LedgerAP InvoiceStatus varchar(1) 

LedgerAR InvoiceStatus varchar(1) 

LedgerEX InvoiceStatus varchar(1) 

LedgerMisc InvoiceStatus varchar(1) 

MergeTemplates FileID uniqueidentifier 

MergeTemplates Type varchar(1) NOT NULL 

Opportunity KonaSpace int NOT NULL default (0) 
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Table Name Column Name DataType 

PNPlan ConWBSLevel smallint NOT NULL 
default (3) 

PR  Biller varchar(20) 

PRDefaults Biller varchar(20) 

PRTemplate Biller varchar(20) 

RPPlan ConWBSLevel smallint NOT NULL 
default (3) 

SE AllowChangeDisableLogin varchar(1) NOT NULL 

SE AllowChangePassword varchar(1) NOT NULL 
default ('N') 

SE AllowChangeSupportDocument varchar(1) NOT NULL 
default ('N') 

SE NavConsultant varchar(1) NOT NULL 
default ('N') 

SE NavDashboard varchar(1) NOT NULL 
default ('N') 

SE NavEmpWorkspace varchar(1) NOT NULL 
default ('N') 

SE Navigator varchar(1) NOT NULL 
default ('N') 

SE NavLabor varchar(1) NOT NULL 
default ('N') 

SE NavPlanning varchar(1) NOT NULL 
default ('N') 

SE NavPMWorkspace varchar(1) NOT NULL 
default ('N') 

SE NavTimesheet varchar(1) NOT NULL 
default ('N') 

SE NavUsePlanningAccess varchar(1) NOT NULL 
default ('N') 

SE NavUsePlanningUpdate varchar(1) NOT NULL 
default ('N') 
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Table Name Column Name DataType 

SE NavUsePlanningView varchar(1) NOT NULL 
default ('N') 

SE NavUseProjectAccess varchar(1) NOT NULL 
default ('N') 

SE NavUseProjectUpdate varchar(1) NOT NULL 
default ('N') 

SE NavUseProjectView varchar(1) NOT NULL 
default ('N') 

SEUser DelegateEmployee varchar(20) 

SEUser DelegateInvoiceApproval varchar(1) NOT NULL 

SEUser FlatDashboardStyling varchar(1) NOT NULL 
default ('N') 

SEUser ForceChangePassword varchar(1) NOT NULL 

VEAccounting SEPABIC varchar(35) 

VEAccounting SEPAIBAN varchar(35) 

Changes to Existing Columns 

Table Name Column Name New 
DataType 

Old 
DataType 

AnalysisCubesCurrencyExc
hange 

Rate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

apDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

apDetail PaymentExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

apMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

apMaster PaymentExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 
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Table Name Column Name New 
DataType 

Old 
DataType 

apppChecksW ExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

billINMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

billInvMaster Address1 varchar(250) varchar(100
) 

billInvMaster Addressee varchar(250) varchar(100
) 

cdDetail CheckNo varchar(32) 
NOT NULL 

varchar(12) 
NOT NULL 

cdDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

cdMaster CheckNo varchar(32) 
NOT NULL 

varchar(12) 
NOT NULL 

cdMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

CFGCurrencyExchange Rate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

CFGCurrencyExchangePer
iod 

PeriodAvgRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

CFGCurrencyExchangePer
iod 

PeriodEndRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

CFGICBillingTerms ICBillingVoucherOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

CFGSuffixDescriptions Suffix varchar(150) 
NOT NULL 

varchar(20) 
NOT NULL 

crDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 
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Table Name Column Name New 
DataType 

Old 
DataType 

crDetail RefNo varchar(32) 
NOT NULL 

varchar(12) 
NOT NULL 

crMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

crMaster RefNo varchar(32) 
NOT NULL 

varchar(12) 
NOT NULL 

cvDetail CheckNo varchar(32) 
NOT NULL 

varchar(12) 
NOT NULL 

cvDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

cvMaster CheckNo varchar(32) 
NOT NULL 

varchar(12) 
NOT NULL 

cvMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

ekDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

ekDetail PaymentExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

ekMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

ekMaster PaymentExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

exDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

exDetail PaymentExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

exMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
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Table Name Column Name New 
DataType 

Old 
DataType 

NULL 

exMaster PaymentExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

ICBillingWK VoucherOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

inMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

jeDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

jeDetail RefNo varchar(32) 
NOT NULL 

varchar(12) 
NOT NULL 

jeMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

jeMaster 

 

RefNo varchar(32) 
NOT NULL 

varchar(12) 
NOT NULL 

miDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

miMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

POVoucherDetail PaymentExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

POVoucherMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

POVoucherMaster PaymentExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

PR BillingExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
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Table Name Column Name New 
DataType 

Old 
DataType 

NULL 

PR ProjectExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

PRDefaults BillingExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

PRDefaults ProjectExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

prDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

prMaster CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

PRTemplate BillingExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

PRTemplate ProjectExchangeRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

ReportPresentationCurrenc
y 

Rate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

unDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

upDetail CurrencyExchangeOverrideRate decimal(19,1
0) NOT NULL 

decimal(19,
6) NOT 
NULL 

Removed Columns 

Table Name Column Name DataType 

ICBillingWK CashBasisTimePost varchar(1) NOT NULL 
default ('N') 
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Table Name Column Name DataType 

ICBillingWK ErrorMsg varchar(max) 

Renamed Columns 
No columns were renamed. 

New Objects 

Object Name Object Type 

GetConCatEmpRole Function 

PM$tabPlanHasNonNavData Function 

PN$ConRate Function 

PN$ExpConMult Function 

PN$tabConRes Function 

PN$tabConTask Function 

AddDefaultFilter Stored Proc 

CreateApproverTable Stored Proc 

PNDelConsultant Stored Proc 

PNSpreadConTPD Stored Proc 

DeleteCFGBillApprovalTrigger Trigger 

InsertCFGBillApprovalTrigger Trigger 

PNSyncOpportunityTrigger Trigger 

PNSyncProjectTrigger Trigger 

UpdateCFGBillApprovalTrigger Trigger 

CFGBillApproval View 

Removed Objects 

Object Name Object Type 

CreateDefaultKPI Stored Proc 
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Renamed Objects 
No objects were renamed. 
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Appendix A: Vision 7.0 SP1 Hot-Fixed Software 
Issues Resolved 
The following are summaries of the software issues that were resolved in the 7.0 SP1 hot fixes 
issued after the 7.0 SP1 General Availability release that are also fixed in the 7.1 release. 

Software Issues Resolved in Hot Fix 001 
   

 

 Vision 

 Deltek Defect Tracking Number: 352571 

 Description: After you upgraded to version 7.0, all previously created user-defined grids 
now had one blank row. The row could not be deleted. 

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: None. 

Additional Notes: If you had user-defined grids that contained some required fields and 
you entered a new record that did not need data to be entered in the user-defined grids, 
the record could not be saved without entering data in the required grid field. You were 
unable to delete the grid row. 

   

 Deltek Defect Tracking Number: 363574 

 Description: In Vision Navigator Timesheets, if you had Windows Authentication enabled 
and you submitted a timesheet with an electronic signature, you received an error 
message.  

Customers Impacted: This defect applies to Vision 6.2 SP2 Navigator. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

 Deltek Defect Tracking Number: 363992 

 Description: When a Workflow button was added to a user-defined info center, the 
workflow was processed for all records within the user-defined info center instead of the 
currently selected record.   

Customers Impacted: This issue applies to Vision 7.0 SP1 users.  
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Workaround Before Fix: None.  

Additional Notes: None. 

   

Connect for Microsoft Outlook 

 Deltek Defect Tracking Number: 343931 

 Description: After you installed Connect for Microsoft Outlook 7.0 SP1 and synchronized, 
you received the following error: “Internal Error On Database - Invalid escaping used 
when generating controls_attributes.js.” This occurred because there was a backslash "\" 
in a screen designer label. 

Customers Impacted: This applies if you installed Vision 7.0 SP1 Connect for Microsoft 
Outlook. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

 Deltek Defect Tracking Number: 365203 

 Description: In Connect for Microsoft Outlook, the Organization field was missing for 
Opportunities.  

Customers Impacted: This issue applies to Vision 6.2 SP2 and later versions of Connect 
for Microsoft Outlook.   

Workaround Before Fix: None.  

Additional Notes: None. 

   

Configuration 

Workflow 

 Deltek Defect Tracking Number: 347620 

 Description: When using the Create Project from Opportunity feature with a stored 
procedure workflow, the associated custom fields were not updated and the project record 
was not created.  
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Customers Impacted: This issue applies to Vision 7.0 SP1.  

Workaround Before Fix: None.  

Additional Notes: None. 

   

User Initiated Workflows 

 Deltek Defect Tracking Number: 365033 

 Description: When you inserted a Create Activity action into the Actions grid on the User 
Initiated Workflow form, the Activity Configuration dialog box displayed. However, the 
toolbar at the top of the Notes field in that dialog box did not have an Insert Field option. 
That option was previously available in version 5.1 and should have been available in 
subsequent versions. 

Customers Impacted: This defect applies to Vision 6.0 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Human Resources 

Payroll 

Quarterly Processing 

 Deltek Defect Tracking Number: 364856 

 Description: New York Electronic File showed an incorrect wage amount in the Gross 
Wages Paid This Quarter field.  

Customers Impacted: Affects clients processing quarterly taxes for New York.  

Workaround Before Fix: The file may be edited manually.  

   

Info Center 

 Deltek Defect Tracking Number: 364106 

 Description: When a user-defined info center name is too long, you could not create a 
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user-defined field that linked back to the info center.    

Customers Impacted: This issue applies to Vision 7.0 SP1.  

Workaround Before Fix: None.  

Additional Notes: None. 

   

Mobile CRM 

 Deltek Defect Tracking Number: 348316 

 Description: The following error displayed in Touch CRM upon login: Cannot retrieve 
global settings. The underlying error was Max JSON string length exceede. These 
errors prevented you from continuing into the application.  

Customers Impacted: This issue applies to Vision 6.2 SP2 and later versions.  

Workaround Before Fix: None.  

Additional Notes: None. 

   

Planning 

 Deltek Defect Tracking Number: 348889 

 Description: When you clicked the Include in Utilization and Project Reports check 
box to select it, Vision took a long time to process that mouse click and display the check 
mark. 

Customers Impacted: This defect applies to customers using Planning in Vision 6.2 SP2 
and later versions. 

Workaround Before Fix: None.  

Additional Notes: None. 

   

Reporting 

General Ledger 

 Deltek Defect Tracking Number: 352502 
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 Description: If you included a column for a user-defined currency field on the Balance 
Sheet and generated the report in a presentation currency, the report contained no data. 

Customers Impacted: This defect applies to customers using the Multicurrency feature in 
Vision 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Utilities 

Advanced Utilities 

Project Closeout 

 Deltek Defect Tracking Number: 356144 

 Description: When Project Closeout processed, the application did not update Unbilled 
Services Gains and Losses WBS1 in Individual Profit Centers and in Company 
Setting/Gains and Losses.  

Customers Impacted: Affects clients with Gains and Losses enabled.  

Workaround Before Fix: After closeout is processed, manually modify the WBS1 
Unbilled Services Gains and Losses WBS1 in Individual Profit Centers and in Company 
Setting/Gains and Losses.  

Additional Notes: None. 

   

Key Conversions 

 Deltek Defect Tracking Number: 352515 

 Description: Several Key Conversions and Key Formats processes did not convert work 
breakdown structure elements for unbilled services gains and losses accounts on the 
Gains and Losses tabs of Accounting Company Settings (Configuration » Accounting » 
Company Settings) and Individual Organization Setup  (Configuration » Organization 
» Individual). Those processes are listed below under Additional Notes. 

Customers Impacted: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround Before Fix: After running the Key Conversions or Key Formats process, 
manually make the changes on the configuration forms. 

Additional Notes: 
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Key Conversions processes: 

• Account 
• Project WBS1 
• Phase WBS2 
• Task WBS3 
• Enabled Phases/Tasks 
• Disable Phases/Tasks 

Key Formats processes: 

• Account 
• Project WBS1 
• Phase WBS2 
• Task WBS3 

   

Weblink Utility 

 Deltek Defect Tracking Number: 365976 

 Description: If a Web server error occurred when you accessed Vision or Weblink, you 
received a "Variable SaaSInstance not found" error instead of a message describing the 
actual problem. 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 

  

State of Idaho — Regulatory Update 

 Idaho has made the following updates: 

  Personal exemption amount increased to $3,800. 

      Tax tables are updated. 
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Software Issues Resolved in Hot Fix 002 

Vision 

 Deltek Defect Tracking Number: 366639 

 Description: A user whose role had Subtotals Only access to labor cost rates and 
amounts could see employee labor cost amounts on the Project Progress report if they 
generated the report with seven or more grouping levels and displayed subtotals by 
employee (i.e., if either Current by Employee or JTD by Employee was selected in 
Labor Detail on the Labor & Expense tab of the Options dialog box for the report). 

Customers Impacted: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround Before Fix: None. 

Additional Notes: The multiple grouping levels that resulted in the problem could have 
been a combination of labor code levels selected for display on the Labor & Expense tab 
of the Options dialog box and grouping options selected on the Sorting/Grouping tab. 

   

Billing 

 Deltek Defect Tracking Number: 262462 

 Description: When an expense item that included a business reason was transferred 
from direct to reimbursable, the business reason did not display on the Billing Backup 
report.  

Customers Impacted: This issue applies to Vision 7.0 SP1 and later.  

Workaround Before Fix: None.  

Additional Notes: None. 

   

 Deltek Defect Tracking Number: 341601 

 Description: You received an error when you accepted an invoice in Interactive Billing if 
all of the following were true: 

• Your Vision configuration on the Reporting tab of the Accounting System Settings 
form has Reporting Realization by Employee selected and Frequency set to 
Invoice. 

• The Windows Regional Settings on your computer were set up to use a comma 
as the decimal separator. 

• The invoice information was displayed at the WBS1 (project) level in Interactive 
Billing when you accepted the invoice. 
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• The records to be billed on the invoice included a labor record with a non-zero 
cents amount. 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: Make sure you are not at the WBS1 level in Interactive Billing 
when you accept the invoice.  

Additional Notes: None. 

  

   Batch Billing 

 Deltek Defect Tracking Number: 368063 

 Description: If you scheduled Batch Billing to run on the Process server, the process 
failed and returned a termination error. 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Connect for Microsoft Outlook 

 Deltek Defect Tracking Number: 347343 

 Description: If a client or vendor had duplicate primary addresses, this caused the 
Connect for Microsoft Outlook synchronization to fail.  

Customers Impacted: This defect applies to Vision 6.1 SP2 and later Connect for 
Microsoft Outlook users. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Info Center 

 Deltek Defect Tracking Number: 349378 

 Description: The auto numbering option was not recognizing Values Mapped when using 
a lookup from the User-Defined Info Center.  
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Customers Impacted: This issue applies to Vision 7.0 SP1 and later versions.  

Workaround Before Fix: For a custom drop-down list, remove the Limit Entry to 
Values List option so the value from the User-Defined Info Center can be applied and 
mapped correctly.  

Additional Notes: None. 

   

Reporting 

Accounting 

 Deltek Defect Tracking Number: 349814 

 Description: For Payroll and Employee Expense checks, when a payment to an 
employee was split between a check and an EFT, the check did not display on the check 
register.  

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: For Payroll payments, see the Bank Reconciliation report and 
Payroll Journal. For Employee Expense payments, see the Accounting » Check 
Review. On the Check Detail screen, the check amount is listed in the Payment Amount 
field. The EFT amount is listed in the Direct Deposit grid. 

Additional Notes: None. 

   

Accounts Receivable 

 Deltek Defect Tracking Number: 350079 

 Description: If you previewed the AR Aged report with any option other than None in 
Client Info to Display on the Options tab of the Options dialog box for the report, and 
then you clicked the Show or Hide Advanced Search icon in the Preview window to 
perform an advanced search, some search criteria that should have returned results did 
not do so. The Results tab was blank. 

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 
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Employee 

 Deltek Defect Tracking Number: 346601 

 Description: If you included a user-defined calculated field as a column on the Time 
Analysis report and that field was defined with Perform Calculation On set to Detail 
Lines and with Sum Up Calculated Amounts on Total Lines selected, some total 
amounts in that report column were not correct. 

Customers Impacted: This defect applies to Vision 6.0 and later versions. 

Workaround Before Fix: Select the all detail and total lines option in Perform 
Calculation On. 

Additional Notes: None. 

   

Project 

 Deltek Defect Tracking Number: 269059 

 Description: If you generated the Office Earnings report with a selection other than 
Project Budgeting in Budget Source on the Budget tab of the Option dialog box for the 
report, the % Labor Comp. Rpt and % Expense Comp. Rpt columns on the report were 
blank.   

Customers Impacted: This defect applies to Vision 7.0 and later versions.  

Workaround Before Fix: None.  

Additional Notes: None. 

 

Transaction Center 

 Deltek Defect Tracking Number: 365540 

 Description: Performance was very slow when using the Units by Transaction entry. This 
was caused by large numbers of unit tables and unit combinations in the database, and 
the fact that the Unit grid row was automatically populated by a default unit table when 
none was defined. 

Customers Impacted: This issue applies to all Vision versions. 

Workaround Before Fix: None. 

Additional Notes: As part of this performance improvement, the unit table drop-down list 
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was changed to a lookup dialog box. 

  

Regulatory—International (Billing Invoices) 

 Description: In previous versions, Vision did not include tax codes with a 0 tax rate on 
client invoices or in the transactions posted for those invoices. However, to conform to 
regulatory requirements, firms in many European countries and in Australia need to 
display tax codes on client invoices even when the tax rate for a tax is 0. This 
enhancement meets that need. If tax auditing is enabled and if the tax basis is not 0, tax 
codes with 0 rates are now included, as applicable, on both regular and retainage 
invoices at the WBS level at which taxes are applied. 

 

 

Software Issues Resolved in Hot Fix 003 

Vision 

 Deltek Defect Tracking Number: 340414 

 Description: If a project associated with the realized gain or realized loss account for 
unbilled services in either Accounting Company Settings (Configuration » Accounting » 
Company Settings) or Individual Organization Setup (Configuration » Organization » 
Individual) used a revenue method other than N (No Revenue Recognition), the 
Revenue Generation process could have unexpected and incorrect results. To avoid this 
situation, Vision now only allows you to select from projects that use the N revenue 
method when you associate a project with a realized gain or realized loss account for 
unbilled services. 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

API 

 Deltek Defect Tracking Number: 368702 

 Description: If you use VisionXtend APIs to import employee expense data entry into 
Vision and you use the Multicurrency feature, you received the following error message 
even for valid accounts: "The AccountCurrencyCode of the Account does not match the 
CurrencyCode of the master record."  

Customers Impacted: This defect applies to VisionXtend 7.0 SP1 only if you use the 
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Multicurrency feature. 

Workaround Before Fix: None.  

Additional Notes: None. 

   

Billing 

 Deltek Defect Tracking Number: 349551 

 Description: If, in the billing terms for a project, you selected the option to display 
timesheet comments on the the Billing Backup report, the report displayed extra lines with 
a 0.00 amount for overtime hours. 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: Either generate the report as a Microsoft Word document and 
remove the extra lines, or do not select the option to include timesheet comments. 

Additional Notes: This problem only occurred when overtime was entered separately 
from regular hours. If overtime was entered on the same row as regular hours in a 
timesheet, for example, this problem did not occur in that case. 

   

Calendar 

Activities 

 Deltek Defect Tracking Number: 363993 

 Description: When the employees on the Attendees tab in Calendar » Activities were 
changed by a user other than the originator, an error occurred.  

Customers Impacted: This issue applies to Vision 7.0 SP1.  

Workaround Before Fix: None.  

Additional Notes: None. 

   

Configuration 

Security 
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 Deltek Defect Tracking Number: 366532 

 Description: When Pending Account Review is selected on the Project lookup on the 
Record Access tab, the proper security rights were not applied and access was still 
available to all records.  

Customers Impacted: This issue applies to Vision 7.0 SP1 and later versions.   

Workaround Before Fix: None.   

Additional Notes: None. 

   

Human Resources 

Payroll 

Quarterly Processing 

 Deltek Defect Tracking Number: 368826 

 Description: In the New York Quarterly SUTA  electronic file, record 1E, fields 3-4, does 
not report the quarter correctly. Instead, it defaults to 12 as the quarter, no matter which 
quarter is being processed.  

Customers Impacted: Affects all payroll users filing New York Quarterly SUTA electronic 
file.  

Workaround Before Fix: Edit the file manually by changing record 1E fields 3-4 to one of 
the following ending quarters: 03, 06, 09, 12.  

   

 Deltek Defect Tracking Number: 369887 

 Description: The CA Quarterly Electronic Filing .xml file is rejected due to errors that fail 
the state validation rules.  

Customers Impacted: Affects all clients submitting CA .xml files.  

Workaround Before Fix: Manually modify the .xml file. 

   

Proposals 

SF330 Proposals 
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 Deltek Defect Tracking Number: 367103 

 Description: When you merged an SF330 proposal, you received an “Invalid character” 
error message for some of the proposal sections.  

Customers Impacted: This defect applies to Vision 6.2 SP2 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Reporting 

Project Planning 

 Deltek Defect Tracking Number: 367414 

 Description: The graph section of the Resource Utilization by Organization report always 
included only hard book hours, even if you selected Soft Book Hours under Show on 
Plan Level Rows on the General tab of the Options dialog box for the report. Thus, if you 
selected that option, the data in the graph section may have been incorrect. 

Customers Impacted: This defect applies to customers using Planning in Vision 6.2 SP2 
and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 
 

  

Software Issues Resolved in Hot Fix 004 

Human Resources 

Payroll 

 Deltek Defect Tracking Number: 368714 

 Description: In the Employee Info Center, there was an incorrect validation that did not 
allow you to add a second withholding code when processing payroll.  

Customers Impacted: This issue applies to Vision 7.0 SP1 and later versions.  

Workaround Before Fix: None.  
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Additional Notes: None. 

   

Reporting 

Project 

 Deltek Defect Tracking Number: 367019 

 Description: The Start Date and End Date fields on the Project Earnings report 
displayed 1/1/1900 instead of the correct dates. 

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 

Software Issues Resolved in Hot Fix 005 

Vision 

 Deltek Defect Tracking Number: 370571 

 Description: If you use VisionXtend APIs, custom fields were not returned with the 
GetSchema method.  

Customers Impacted: This defect applies to VisionXtend 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Billing 

Interactive Billing 

 Deltek Defect Tracking Number: 345824 

 Description: The amount in Invoice Total in the grid in the Employee Realization 
window was not correct when you displayed realization information for a lower level of the 
WBS structure (a phase, for example). When employees at the phase (WBS2) or task 
(WBS3) level display in the grid, the amount in Invoice Total should equal the sum of the 



Appendix A: Vision 7.0 SP1 Hot-Fixed Software Issues Resolved 

 

Release Notes 72 

 

realization amounts in the grid. Instead, it displayed the amount for whatever WBS 
element was previously selected.  

Customers Impacted: This defect applies to Vision 7.0 SP1. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Connect for Microsoft Outlook 

 Deltek Defect Tracking Number: 372436 

 Description: When you added Vision clients in Connect for Microsoft Outlook, the Client 
ID field did not populate. This caused associated client inserts to fail in the same 
synchronization.  

Customers Impacted: This defect applies to Vision 6.2 SP2 Connect for Microsoft 
Outlook and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Proposals 

SF330 Proposals 

 Deltek Defect Tracking Number: 368324 

 Description: After you installed the Vision 7.0 SP1 Hot Fix 001, some existing merge 
templates produced merged .rtf documents with incorrect formatting.  

Customers Impacted: This defect applies to Vision 7.0 SP1 Hot Fix 001. 

Workaround Before Fix: None. 

Additional Notes: None. 

   

Utilities 

Advanced Utilities 



Appendix A: Vision 7.0 SP1 Hot-Fixed Software Issues Resolved 

 

Release Notes 73 

 

Data Import 

 Deltek Defect Tracking Number: 370631 

 Description: When using the Data Import Utility for a Cash Receipt data import, you 
received an import error for a cash receipt record with an asset account if the account 
was not mapped. 

Customers Impacted: This defect applies to Vision 7.0 SP1 and later versions. 

Workaround Before Fix: Use Vision to enter the cash receipt. 

Additional Notes: None. 
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